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1. The enclosed Allied Fuels and Lubricants Publication AFLP-3390, Edition A,
Version 2, GUIDE SPECIFICATION AND INSPECTION STANDARDS FOR FUEL
SOLUBLE LUBRICITY IMPROVERS (S-1747), which has been approved by the
nations in the Petroleum Committee, is promulgated herewith. The agreement of
nations to use this publication is recorded in STANAG 3390.

2. AFLP-3390 Edition A, Version 2 is effective upon receipt and supersedes
AFLP-3390, Edition A, Version 1, which shall be destroyed in accordance with the local
procedure for the destruction of documents

3. No part of this publication may be reproduced, stored in a retrieval system,
used commercially, adapted, or transmitted in any form or by any means, electronic,
mechanical, photo-copying, recording or otherwise, without the prior permission of the
publisher. With the exception of commercial sales, this does not apply to member
nations and Partnership for Peace countries, or NATO commands and bodies.

4. This publication shall be handled in accordance with C-M(2002)60.

< Waginls.

Edvardas MAZEIKIS
Major General, LTUAF
Director, NATO Standardization Office
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SECTION 1 GENERAL

0101.

0102.

0103.

0104.

0105.

0106.

This ALFP-3390 is:

a. To standardize the qualification, inspection and test requirements for aviation
fuel additives designed to enhance the lubricating characteristics of the fuel as
well as to produce and maintain a list of products acceptable to all Member
Nations (MN).

b. To align their qualification and procurement specifications for aviation fuel
lubricity improving additives (LIA) with the requirements of this STANAG.

C. To use one of the approved additives listed in Section 3 when exchanging fuel
between MN.

d. To only use the Section 5 method for di-linoleic acid content as a rough check
on the presence of LIA on fuel received from MN and to use the ASTM D5001
fuel lubricity performance test as the referee method to verify the fuel exhibits
adequate lubricating performance.

e. To acknowledge the alternative methods for measuring a fuel's lubricating
performance:

i. Section 6, used by the Czech Republic and other countries which
operate equipment designed and built in the former Soviet Block.

ii. Section 7, used by the UK MOD to qualify new lubricity improving
additives.

LIA shall meet the requirements of Table A-1 of Section 2 and the performance
requirements of Sections 3 and 4. The minimum effective concentration for lubricity
improvement shall be in accordance with Section 3. The inspection and test
requirements for aviation fuel lubricity improvers shall be in accordance with
Section 4.

The inspection and test requirements for approved LIA shall be listed in Section 4.
The additive supplier is required to provide certification of these requirements for each
production batch.

Section 5 provides details of a procedure for determining the concentration of the
additives in aviation fuels by measuring the di-linoleic acid content of the fuel. Since
each additive contains a different concentration of di-linoleic acid and each aviation
fuel contains some di-linoleic acid content, accurate quantification of the additive
content requires knowledge of both the specific approved additive used as well as the
di-linoleic acid content of the base fuel.

Sections 6 and 7 provide detailed information on lubricity performance tests used by
some Member Nations.

The inspection tests of Section 5 shall be carried out on dormant stocks of additive at
least once every two years.

1-1 Edition A Version 2
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0107. The standard methods to be used are those published in the latest edition of:

a.

I.P. Standards for Petroleum and its Products. Published by the Energy
Institute, 61 New Cavendish Street, London W1G 7AR, England or online at
https://www.energyinst.org/.

ASTM Standards: Volumes 05.01 and 05.02 (Petroleum Products and
Lubricants). Published by ASTM International, 100 Barr Harbor Drive, PO Box
C700, West Conshohocken, PA 19428-2959, USA or online at
http://www.astm.org/.

Note: Where both I.P. and ASTM Methods are quoted, either may be used.

1-2 Edition A Version 2
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SECTION 2

MINIMUM QUALIFICATION STANDARDS FOR FUEL SOLUBLE

LUBRICITY IMPROVERS

0201.

0202.

Table A-1 below lists the minimum requirements participating MNs have agreed to
include in their National specifications.

Table A-1 is not designed to be a complete qualification document by itself. Many
other test requirements are included in National specification to insure the approved products
are compatible with the using equipment, fuel systems components, as well as fuels produced
by various refiners and other approved fuel additives.

TABLE A-1
Test Property Units Limits Method
ASTM/IP
1 Density kg/m?3 Report D4052/IP 365
2 Flash Point °C Report D93/IP 34
3 Viscosity mm?/s Report D445/IP 71
4 Acid Number mg KOH/g Report D664/IP 177
5 pH Report D664/ IP 177
6 Ash Content %m/m Max 0.10 D482/IP 4
I Pour Point °C Max -18 D97/IP 15
8 Minimum Effective g/m? Report D5001!
Concentration (MEC) for (Max scar 0.65 mm)
Lubricity

9 Micro Separometer Rating Min 70 D3948
(MSEP)

10 Solubility There shall be no As prescribed
precipitation, by National
cloudiness, or other Specification
evidence of
incompatibility

11 Compatibility There shall be no As prescribed
precipitation, by National
cloudiness, or other Specification
evidence of
incompatibility

! Test fuel shall be a low lubricity fuel selected in accordance with National Specification.
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SECTION 3 LIST OF APPROVED LUBRICITY IMPROVERS

0301. This Section lists the aviation fuel LIA which have been individually approved and
jointly agreed to by the Member Nations. Table B-1 also includes the minimum concentration
which is required for each additive.

0302. The primary active ingredient in the approved lubricity improving additives is di-linoleic
acid. Since some MN's analyze a fuel for its di-linoleic acid content in order to confirm the
addition of the lubricity improver additive, Table B-1 includes the approximate concentration
the injection of the minimum required amount of each lubricity improver will impart to the fuel.
These values are only approximations and based upon the gel permeation chromatography
(GPC) analysis (see Section 5) of undiluted products. Results of this analysis are shown in
Table B-3.

TABLE B-1
Minimum Concentration Corresponding Approximate
Required Di-linoleic Acid Concentration
Product )
in Fuel
g/m? g/m?
DCI-4A 9 5.4
DCI-6A 9 Unknown
HITEC 580 15 6.7
NALCO 5403 12 4.1
NALCO 5405 9 Unknown
SPEC-AID 8Q22 9 Unknown
TOLAD 351 9 4.2
TOLAD 4410 9 6.3
UNICOR J 9 4.3
TABLE B-2
Minimum Concentration Maximum Allowable
Product Required Concentration
g/m? g/m?
DCI-4A 9 24
DCI-6A 9 15
HITEC 580 15 23
NALCO 5403 12 23
NALCO 5405 9 23
SPEC-AID 8Q22 9 24
TOLAD 351 9 24
TOLAD 4410 9 23
UNICOR J 9 23
3-1 Edition A Version 2
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TABLE B-3
Average percentage measured
Product as di-linoleic acid by GPC*

DCI-4A 59.7

DCI-6A Unknown
HITEC 580 445
NALCO 5403 34.0

NALCO 5405 Unknown

SPEC-AID 8Q22 Unknown
TOLAD 351 47.0
TOLAD 4410 70.0
UNICOR J 48.0

* Average per cent varies from batch to batch.

TABLE B-4
PRODUCT MANUFACTURER
DCI-4A Innospec Fuel Specialties,
DCI-6A LLC
HITEC 580 Afton Chemical Corp.
NALCO 5403 Nalco Co.
NALCO 5405
SPEC-AID 8Q22 GE Betz Inc.
TOLAD 351 Baker Petrolite Corp.
TOLAD 4410
UNICOR J Dorf Ketal Chemicals India
Private Ltd

3-2
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SECTION 4 INSPECTION AND TEST REQUIREMENTS FOR AVIATION FUEL LUBRICITY IMPROVERS
TABLE C-1
CHARACTERISTIC TEST REQUIREMENTS/LIMITS TEST METHODS
SPEC-
HITEC | NALCO | NALCO TOLAD | TOLAD | UNICOR JOINT
DCI-4A | DCI6A | “'5e0” | 5403 | 5405 8%'22 351 | 4410 J AsTMap | ASTM | 1P

Ash Content, % m/m D482/4

max <0.05 <0.05 <0.05 <0.05 <0.05 <0.05 <0.10 <0.05 <0.05 (1)
Flash Point, °C

min 34 33 66 60 60 50 39 39 52 D93/34
Total Acid No.,
mg KOH/g D664/177

min 100 120 80 80 130 100 95 130 110 (2)

max 124 150 100 110 160 130 120 155 126
Phosphorus, %m/m D1091 149

max <0.01 <0.01 <0.01 <0.01 <0.01 <0.01 <0.01 <0.01 <0.01 (3) (3)
Pour Point, °C

max .18 .18 .18 .18 .29 .18 222 .18 .18 D97/15
Density at 15°C,
kg/m?3 D1298/160

min 928 935 910 890 920 840 900 930 920 D4052 365

max 968 975 925 940 960 920 940 960 960
Viscosity at 40°C,
mm?/s

min 43 45 110 15 40 65 30 120 55 DA45/71

max 68 60 136 35 90 105 50 220 95
BOCLE minimum
effective

H 3
concentration (g/m?) 9 9 15 12 9 9 9 9 9 D5001
that gives a wear (4)
scar diameter of
0.65 mm or less
4-1 Edition A Version 2
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NOTES: 1. The crucible shall be made of platinum and shall be heated to 775+25°C.
2. It is essential that the reagents be prepared strictly in accordance with test D664/IP 177 and that titrants be freshly
standardized.
3. Use the photometric molybdivanado procedure.
4, Evaluate lubricity of additive in clay-treated F-34 or F-35 fuel or Exxon ISOPAR M (USA). Concentration of additive
shown in Table A-1 should give BOCLE wear scar of 0.65 mm or less.
4-2 Edition A Version 2
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SECTION 5 DETERMINATION OF THE DI-LINOLEIC ACID CONTENT IN
AVIATION TURBINE FUELS

SCOPE

0501. This Section describes a procedure for determining the di-linoleic acid content of
aviation turbine fuels. Dimer acid is a principal constituent of the approved pipeline corrosion
inhibitors/lubricity improvers (currently referred to as lubricity improvers in this AFLP) and is
used to monitor their presence at the correct level.

OUTLINE OF METHOD

0502. Fuel is extracted with alcoholic sodium hydroxide solution. The alkaline extract is
acidified and extracted with chloroform. The di-linoleic acid thus extracted from the fuel is
determined by gel permeation chromatography.

APPARATUS
0503. High Performance Liquid Chromatography (HPLC)

a. HPLC has to be designed for operation at ambient temperature, equipped with a
refractive index (RI) detector, a chart recorder or a data processing station. The
HPLC coming from Waters has three main parts: the Sample Processor (Waters
715 Ultra Wisp), the Differential Refractometer (Waters 410) and the System
Controller (Waters 600E).

b. As adegas gas, helium is used, the mobile phase is tetrahydrofuran (THF) and
the solvent that rinse the syringe is heptane.

c. Allliquids that pass through the HPLC need to be filtered with a filter Nylon 66
of size 0.45um x 47 mm.

0504. Gel Permeation Chromatography (GPC)

a. Column (or set of columns) must allow a separation of di-linoleic acid from
monomer and trimer. This is achieved by a column suitable for the molecular
weight range <1000.

b. An Ultrastyragel Gel Permeation column with spherical particle size of 5 ym, an
inner diameter of 7.8 mm, a length of 300mm can be used. The particle substrate
is a polymer. The column is suitable for molecular weight range between 50 to
1500. The pH range of the column is from 2 to 12 and has THF as packing
solvent.

5-1 Edition A Version 2
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MATERIALS

a. Sodium hydroxide, 0.1M alcoholic
solution

b. Tetrahydrofuran (THF)

c¢. Sodium sulphate, 2% solution

d. Standard solution of di-linoleic acid
(Equivalent to 10.0 mg/I of fuel)
(See Note 1)

e. Kerosene

f. Hydrochloric acid

g. Chloroform

AFLP-3390

Dissolve 2g sodium hydroxide
pellets in 300ml distilled water, add
200 ml of denatured alcohol and
mix well.

HPLC grade, for use in GPC

Dissolve 20g of sodium sulphate
decahydrate in distilled water, and
make up to one litre.

Dissolve 0.0800g di-linoleic acid in
THF, transfer to a 100 ml volumetric
flask and make up to the mark with
THF.

Mix equal volumes of laboratory
reagent grade hydrochloric acid
and distilled water.

Laboratory reagent grade

1 Commercial supplies of NOTE 1: Commercial supplies of di-linoleic acid
contain variable amounts of the monomer and trimer. Details of suitable supplies for
standardization may be obtained from Materials Quality Assurance Directorate,
Harefield House, Harefield, Uxbridge, Middlesex UB9 6BB.

PROCEDURE

The procedure is to be completed as follows:

a. Extraction of Di-Linoleic Acid. Extract di-linoleic acid as follows:

(1) Place 800 ml of the fuel to be analyzed in a two litres separating-funnel.

(2)  Add 100 ml of the alcoholic sodium hydroxide solution to the funnel and
shake the mixture for 3 minutes. Make sure to evacuate gases that are

formed.

(3) Allow the layers to separate for 5 minutes and run the lower layer
(aqueous layer) off into a 250 ml separating funnel.

5-2
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(4)  Add 5 ml of the diluted hydrochloric acid and 20 ml of chloroform to the
contents of this funnel and shake the mixture for 2 minutes. Make sure to
evacuate gases that are formed.

(5) Allow the layers to separate for 5 minutes and transfer the lower layer
(organic layer) to another 250 ml separating funnel.

(6)  Add 50 ml of the sodium sulphate solution to the contents of this funnel
and shake the mixture for one minute. After separation run the lower layer
(chloroform layer) into a 100 ml beaker and gently evaporate the solution
almost to dryness on a water bath. (NOTE: It is essential to stop
application of heat when evaporation is nearly complete; any trace of
solvent remaining will not affect the result obtained.)

(7)  Dissolve the residue in the beaker in a small quantity of THF, and transfer
to a 10 ml graduated flask, then make up to the mark with THF.

0507. Extraction of Standard Solution. Extract a standard solution as follows:

(1) Pipette 10 ml of the standard solution of di-linoleic acid into a two litres
separating funnel containing 800 ml of kerosene.

(2) Swirl gently to mix and extract the di-linoleic acid to produce a solution in
THF as described in 5.1.a (2) to (7).

0508. GPC Determination. Determine the GPC as follows:

(1) Filter approximately two to four litres of the mobile phase (THF) with a Nylon
66 filter of 0.45um x 47 mm size.

(2) With the THF filtered, rinse the GPC column at a flow of 1ml/min for 5
minutes.

(3) Go to Edit > Monitoring > Settings. Condition the column with filtered THF at
1ml/min for another 5 minutes. Rinse with the flow at 8 ml/min (watch carefully
the pressure of the column) for 1 or 2 minutes. Reduce the flow to 1ml/min
and when the baseline on the monitor is stable, stop the flow. Quit monitoring
function by clicking on the red button on the screen.

(4) Create a new method by double clicking on Run Samples > HPLC1>OK.
Select Edit > Instrument method

Solvent: Identify the solvent used for mobile phase as THF

Degas: Helium that degas the THF only, at a rate of 20ml/min.

Internal temperature: 30°C

Sampling rate: 1

Unit: mV

Filter time: 1.0

Sensitivity: 16

Polarity: +

Autozero at zero: activated

For the Flow section, the pressure limit is 4000 psi and the

T TT@ T eo0oTp
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programme specify that the flow is Iml/min and in isocratic mode.

(5) In a glass syringe of 10 ml, put 1 ml of the solution of the extracted di-linoleic
acid in THF obtained from 0506.a with a disposable Pasteur pipette. Put a
filter at the end of the syringe. Push the press and pour the sample in a vial
that goes on the HPLC sample tray. Identify the vial correctly. Do the same

for all standards and other samples.

(6) To programme series of injections, quit the Monitoring mode, select the tab
“Sample set”. File > New Sample Set Method > Empty. Click on the first
empty box in the “vial” column. Fill in the table as shown below:

Vial Sample Label Function Processing | Method set Label
name reference
1 (name) seilrr]rjw%(I:;s Normal D"gr;%e'c
# of Inj. Vol , Data start Next inj. Sample I
T ' Run time . Delay . Dilution
injection (ML) (minute) (minute) weight
or : :
(2 or 3) 10 25 0 0 1.0 1.0

(7) Note the peak elution volume (counts) for the di-linoleic acid contained in the
standard solution and measure the height of the peak above the baseline H;
measure the height of the corresponding peak for all the samples injected
above its baseline. Hs.

CALCULATION

0509. The concentration of di-linoleic acid (in mg/I) in the fuel is given by:

Hs x C x 100
Hcx P

where C = Concentration of di-linoleic acid in standard solution (equivalent to 10.0
mg/l if made up as given in the method).

Hc. = Height above baseline for di-linoleic acid chromatogram peak for standard
solution.

Hs = Height above baseline for di-linoleic acid chromatogram peak for sample
solution.

P = % purity of di-linoleic acid used as standard.

5-4 Edition A Version 2

NATO/EAPC UNCLASSIFIED



NATO/EAPC UNCLASSIFIED

AFLP-3390
REPORTING
0510. Report the di-linoleic acid content, in mg/l, to the nearest 0.5 mg/l.
NOTE: Repeatability at the 5 mg/l content has been shown to be:
Coefficient of variation = 3.6%
Standard Deviation = 0.2
5-5 Edition A Version 2

NATO/EAPC UNCLASSIFIED



NATO/EAPC UNCLASSIFIED

AFLP-3390

INTENTIONALLY BLANK

5-6 Edition A Version 2

NATO/EAPC UNCLASSIFIED



NATO/EAPC UNCLASSIFIED

AFLP-3390

SECTION 6 CZECH MINISTRY OF DEFENCE TEST METHOD FOR DETERMINATION OF
LUBRICITY OF AVIATION TURBINE FUELS (FOUR-BALL WEAR TEST MACHINE)

SCOPE

0601. This test method covers a procedure for determination of an aviation turbine fuel
lubricity or lubricity of other fuels by using the Four-Ball Wear Test Machine.

0602. The test method defines the conditions of preparation, performance and evaluation of
test for aviation turbine fuel lubricity. This test method is applied to evaluate a lubricity of
aviation turbine fuels delivered for the Czech Armed Forces according to the appropriate
national military specifications (see Note 1). The test method is also applied as obligatory for
determination of a fuel lubricity in the process of in-service using and storage in Jet Fuel
Storage Installations (JFSIs).

Note 1. F&L Military Specification for Single Fuel F-34 (VJS PHM 1-3-L)

0603. Test Procedure and technical requirements listed in this test method may be applied
to determine lubricity of other fuels for which the lubricity is required according to respective
national military specifications.

PRINCIPLE OF TEST

0604. The principle of the lubricity determination is evaluating wear scar traces forming
because of sliding contact between friction spherical surfaces of test balls, which are immersed
into the tested fuel during the test. The friction contact is based on the four bearing ball set
(four-ball method) where the top turning ball is clamped into the spindle of the test machine
and produces a friction contact by rotation against three lower stationary balls which are
clamped into the steel rounded pot. This three-point contact formed by four bearing balls is
submitted to the axial loading for a rated duration. Parameter of lubricity is defined as average
sizes of wear scar traces, which appear on the three lower balls of the friction set.

SAMPLING AND PREPARATION TO TEST

0605. Fuel samples shall be taken according to the CSN2 EN ISO 3170 or according to
appropriate national military technical instructions. Using of sample bottles made from low-
molecular polyethylene or bottles with galvanized inside coating is not acceptable. For
sampling into a glass sample bottle, it is forbidden to use a taper joint stopper.

0606. Owing to the fact that the test is sensitive to presence of solid particles in the tested
fuel, carry out a filtration of fuel sample through a membrane ultra filter of porosity 0,4 to 0,8
pum before test. Collect fuel passing through filter into a borosilicate vessel or beaker, which
shall be rinsed, three times by filtered fuel to be tested.

2 CSN (Ceska Technicka Norma) Czech Technical Standard
6-1 Edition A Version 2
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MATERIALS AND REAGENTS

0607. Test balls

(2) Shall meet the technical requirements of CSN ISO 3290. Balls diameter
are 12.7 mm, degree of accuracy 10, Rockwell hardness 63-65 HRC. Balls are
made from roll bearing steel having usually chemical composition as follows
(see Note 2):

C 0,951t0 1,10%
Mn 0,25 to 0,45%
Si 0,15t0 0,35%
P max 0,027%

Sax 0,020%

Cr 1,30 to 1,65%
Nimax 0,25%

CUmax 0,25%

(Ni + CU)max ~ 0,50%

Note 2:Test balls manufactured according to analogical
international standards (e.g., from material according to the AlSI
52100) may be used as well. However they must comply with
above-mentioned technical requirements.

0608. Petroleum spirit with distillation range 70°C to 100°C or n-heptane, boiling point
98,2°C to 98,6°C (at pressure 101,3 kPa).

0609. Cleaner cotton tissue, non-releasing fibers.

0610. Reference fluids:
) Fluid A - diesel fuel, according to the requirements of the ASTM D6079.
2) Fluid B - according to the requirements of the ASTM D6079 and the Table 1 of
this test method.

APPARATUS

0611. Four-Ball Wear Test Machine (see Note 3)

Note 3: Four-Ball Wear Test Machine may be manufactured by PLINT &
PARTNERS LTD, from United Kingdom.

Q) Main functional parts of the Four-Ball Wear Test Machine are following:
- control panel with speed regulation of rotating spindle, timer and temperature
control
- drive unit formed by electric motor, transmission unit with V-belts and
operating rotating spindle
- friction set with loading mechanism

(2) Basic operating parts of test machine is the friction set illustrated on the Fig. 1.
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Fig. 1. Scheme of a Friction Set

The three-point contact is based on four steel test balls grouped in the pyramid form. The
top ball is fixed into the rotating spindle which rotates at a rated speed together with the
ball. A loading mechanism generates an axial load which presses the top ball against
three stationary balls clamped into a pot with a lever. The pot ensures a complete
immersion of four balls into a tested fuel. The lever serves to block the pot and to prevent
a rotation of the pot caused by friction contact between the balls.

The test machine shall enable to regulate a linear progressive speed and to keep a
constant speed in the defined range.

0612. Metallographic microscope capable of 100X magnification equipped with vertical
lighting, slide gauge with micrometric screw enabling to determine an average size of wear
scar traces with definition resolution 1 pm.

0613. Ultrasonic cleaning bath to clean test balls.

0614. Forceps

0615. Glass dish (Petri dish) to place test balls.

0616. Sparking jig to designate a position of wear scar traces.

PREPARATION OF TEST

0617. Before the test, the preparation of the test balls and apparatus is analogical to the test
method ASTM D4172.

0618. Clean a required number of balls from the same package (box of 500 pieces) in an
ultrasonic cleaning bath with petroleum spirit or n-heptane to remove residual anticorrosion
coatings. Once again repeat thorough cleaning procedure with petroleum spirit or n-heptane
and finally dry balls by compressed air. It is not acceptable to touch balls with bare fingers.
Place the balls in the clean glass dish. Balls showing a surface deterioration shall be rejected.
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0619. Thoroughly clean with petroleum spirit or n-heptane all parts of loading friction set (a
part of lever together with pot, elements to clamp lower balls, top ball chuck) which will be in
contact with tested fuel. Then dry them by compressed air. Use only cleaning tissues which
are clean, chemically neutral and non-releasing fibres.

TEST PROCEDURES

0620. Plug the test machine to electricity power outlet. Apply a load of 0,7 kg on the loading
arm. Place three test balls into the pot, centre test balls by using a lock ring and fix balls by
means of the nut wrench with moment of force 55 Nm. Rinse twice the pot with balls with
about 30 ml of tested fuel and then fill the pot with the rated quantity of fuel (20 ml). Insert the
to ball in the chuck and fasten the chuck with the ball into the rotating spindle. Place the lever
with the pot in the test machine right under the top ball. Unblock a loading arm whereby the
balls in the three-point contact are pressed under axial load of 140 N. According to the
operating instructions switch on the drive motor which is set to reach a rated speed of 1500
rpm within 15 s by a continuous way. After 60 s the operation is finished and the test machine
is switched off. As soon as the spindle with the top ball stops to rotate, shift the loading arm
to the initial position and take out the pot with lever from the test machine. Drain tested fuel
out from the pot, dry the balls by an appropriate tissue and by means of sparking jig mark wear
scar traces on the lower ball surfaces. Then use the nut wrench to unscrew lock nut and take
out the balls from pot.

Demount the chuck from the spindle and take out the rotating top ball. Submit all test balls to
visual inspection. Use the three lower balls for microscopical measuring of wear scar traces.

TEST CONDITIONS

0621. Test for lubricity is carried out under these operating conditions:

- Duration to reach the speed 1500 rpm 15 + 1 s (progressive increase 100 rps)
- Speed 1500 + 15 rpm

- Duration of test

(including time to reach operating speed) 60+1s

- Axial load on the three-point contact 140 N (weight of 0,7 kg on loading lever
arm, ratio 1:20)

- Quantity of tested fuel in the pot 20 ml

- Initial temperature of fuel in the pot 20°Cto 25°C

EVALUATION OF TEST RESULTS

0622. Wear scar traces which appear on the three lower test balls are generally of circular
or elliptic shape. Both longitudinal and transverse line at 90° to each other of each scar area
shall be measured by using a suitable microscope. Required resolution of a microscope shall
be 1 um. Calculate value of wear scar trace diameter for one determination (dw)) as arithmetic
average of all six measurings. It means, measuring both longitudinal and transverse axis of
wear scar traces on three balls of one three-point contact. Resulting value of lubricity for
appropriate tested fuel is defined as mean value of wear scar trace size calculated from all
determinations of wear scar traces. Report prospective atypical appearance of wear scar trace
(blue discoloring, irregular trace edge etc.). If there is a trace having irregular shape, carry out
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the evaluating by using so-called "envelope method", it means, measuring at least four axis of
a wear scar trace at 45° to each other.

TEST RESULT

0623. For routine evaluation, carry out at least three parallel measurings of one sample.
Arithmetic average of three determinations is taken as a resultd, :

- d,+ dg2 +d,,; (um)

Results of single determinations for the same tested fuel sample which are ranged
through 290 to 320 pm should not differ more than + 5 pm from arithmetic average.

d

For arbitration test for lubricity shall be carried out at least 5 determinations for the
same sample. Single measured diameters of wear scar traces, detected on single
lower balls of all determinations for the same fuel are submitted to the statistical
evaluation by using a suitable test for outliers with significance level a = 0,05.

0624. Verify a right functionality and accuracy measuring of the test machine by means of
Reference Fluids A and B which meet requirements of the ASTM D6079. If a difference
between two determinations of wear scar traces for both reference fluids is greater than 5 um,
then carry out another test or correcting measures to verify a right functionality and accuracy
of the test machine. Further test or correcting measures are to be carried out as well if an
arithmetic average of two determinations of lubricity differs more than 5 pm in comparison with
an arithmetic average determined for either of both reference fluids. Arithmetic average of
determinations of lubricity for Reference Fluid A is 302 um, for Reference Fluid B is 363 um.
If the Reference Fluid B shows a wear scar trace less than 350um, then the fluid shall be
treated by a clay according to the ASTM D6079 or according to the procedure defined in 11.a
and subsequently the test is to be repeated. This treatment provides removing contaminations,
which adhere on surface and cause a boundary lubrication.

PREPARATION OF LOW-LUBRICITY VERIFICATION FLUID TO EVALUATE LUBRICITY
ADDITIVE EFFECT

0625.  Verification fluids used to evaluate an effect of LIA by means of the Four-Balls Wear
Test Machine shall not contain additives modifying their lubricity properties. To verify
measuring accuracy of the test machine, it is necessary to apply reference fluid Use fluid
ISOPAR M (see Note 4) as low-lubricity Reference Fluid B (see Table 1) mentioned in the
ASTM D6079 or to prepare a suitable low-lubricity fluid from aviation turbine fuels F-34, F-35
or Jet A-1. The low lubricity fluid is prepared by cleaning aviation turbine fuel by passing
through activated silica gel layer of granularity 28-200 mesh (see Note 5).

Note 4: Available from ISOPAR M Exxon Co., USA, P.O. Box 2180, Houston, TX
77001.

Note 5: Low-lubricity fluid from aviation turbine fuels type F-34, F-35 or Jet A-1 prepared
by using silica gel of granularity 28-200 mesh as follows:
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Reagents and Materials:

- aviation turbine fuels type F-34, F-35 or Jet A-1
- silica gel, grade 12, 28-200 mesh

- glass wool

- graduated separatory funnel, capacity of 500 ml
- glass rod

- desiccator

- beakers, capacity of 250 ml

Seal a separatory funnel neck with glass wool by using a glass rod. Then fill the 3/4 of
separatory funnel capacity with activated silica gel of granularity 28-200 mesh. Fill the
separatory funnel with aviation fuel. Take free-dropping away aviation fuel into a
beaker.

The following table gives and example of changes of physical and chemical properties
of aviation turbine fuel F-34 with additives before passing through silica gel layer and
low-lubricity fluid which has been prepared from this fuel by method of passing through
silica gel layer.

Aviation fuel F-34 lost any active superficial matters by passing through a silica gel
layer prepared according to the operating instructions. It happens an important
decrease of electrical conductivity because of removing antistatic additive (SDA) and
also a considerable decrease of total sulfur content (half an initial value).

0626. Three determinations of lubricity fluid shall be carried out on the Wear Test Machine
to verify a right preparation procedure. Average of wear scar trace for reference fluid ISOPAR
M shall not be less than 355 um. Average of wear scar trace of sample of aviation turbine fuel
prepared both by passing through activated silica gel and by procedures defined in the ASTM
D6079 shall not be less than 345 um.

F-34 with Low-lubricit
additives fluid after
Physical and Chemical before :
No . passing Test Method
Property passing 2.
= through silica
through silica
gel
gel
Electrical conductivity,
1. (pS.M1/°C) 269 2 ASTM D2624
Lubricity:
2 | Wear test, dw (Um) 312 351 ZM-PHM-01
3. | Aromatics, (% V/v) 17,83 16,41 ASTM D1319
4. | Microseparometer, (MSEP) 73 100 ASTM D3948
5. | Total Sulphur content (% m/m) 0,062 0,028 ASTM D4294
0627. For calibration, dose an appropriate quantity of lubricity improvement (LI) into a low

lubricity fluid prepared by passing through activated silica gel layer of granularity 28 - 200
mesh. The test the samples prepared as above on the Wear Test machine and evaluate
lubricity. For determination of optimal effective concentration there is need of plotting a
calibration curve with evaluation to follow.
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0628. Reference fluid:

1) Reference Fluid B (ISOPAR M) - paraffinic solvent specified according to the

Table 1.
Table 1: Requirements to the Reference Fluid B
Physical and Chemical Property Test Method Allowable
values

Distillation:
- Initial boiling point, (°C) 199 to 210
- 10 % v/v recovered, (°C), max ASTM D86 205
- 95 % v/v recovered, (°C) report
- Final boiling point, (°C), max 257
Flash point, (°C), min ASTM D93 75
Aromatics, (mg/kg), max AMS 140.319 500
Bromine index, max ASTM D2710 500
Carbonyl content, (mg/kg), max AMS 260.139) 10
Saybolt Colour, (colour unit), min ASTM D156 +30
Copper strip corrosion, 3 hrs at 50°C, ASTM D130 1
(class), max
Sulphur, (mg/kg), max ASTM D3120 5

Note 6: Test method Exxon Chemical Company.

TEST REPORT

0629. Test report shall contain following information:

- identification number of test report;

- type and identification of fuel sample;

- place and date of sampling

- relative standards and rules;

- date of delivery and identification number of sample;
- conditions to test;

- measuring results;

- operator's data;

- test results evaluation.

PRECISION AND BIAS

0630. Repeatability -The difference between two successive results obtained by the same
operator with the same apparatus under constant operating conditions on identical test
material would, in the long run, in the normal and correct operation of the test method, exceed
the following value only in one case in twenty.

Repeatability = 5 um
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Note 7: In order to determine precision of test method it was prepared a sample of aviation
turbine fuel F-34 with additives and another sample of the same fuel without additives (LIA,
SDA and nature lubricity components containing 0.03 % m/m of sulphur). This sample was
prepared from fuel which passed through activated silica gel layer of granularity 28-200 mesh.
The samples of aviation fuels prepared like this were tested 16 times on the Wear Test
Machine. All 16 laboratory tests on one fuel sample were carried out by the same operator.
The two sides confidence interval L1, for appropriate test method was calculated from
measured values by using basic statistical functions (arithmetic average, standard deviation,
test for outliers) with significance level a = 0,05.

0631. Bias - The procedure in this test method has no bias because the value of ball scar
width can only be defined in terms of a test method.

STANDARDS
CSN ISO 3290 Rolling Bearings-Balls-Dimensions and Tolerance
CSN ENISO 3170 Liquid Petroleum Products - Manual Sampling
ASTM D 4172 Standard Test Method for Wear Preventive Characteristics of
Lubricating Fluid (Four-Ball Method)
ASTM D 6079 Standard Test Method for Evaluating Lubricity of Diesel Fuels

by the High-Frequency Reciprocating Rig (HFRR)

RELATIVE STANDARDS

CSN 01 8003 Principles for Safety Work in Chemical Laboratories
CSN 65 6540 Petroleum Spirits
VIS PHM ¢ 1-3-L Military Specifications for F&L 1-3-L, Single Fuel F-34
DESCRIPTORS: lubricity, aviation turbine fuel, Wear Test Machine
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SECTION 7 UK MINISTRY OF DEFENCE PROCEDURE FOR DETERMINING
LUBRICITY IMPROVING POTENTIAL

0701. SCOPE

a. This method describes a procedure used to determine the lubricity enhancing
characteristics of candidate fuel soluble lubricity improving additives as a qualification
test to QPL 68-251. For qualification purposes and until precision criteria are
established, this procedure will be carried out at the manufacturer's own expense at
QinetiQ Ltd, Fuels and Lubricants Centre, Building 415, Cody Technology Park, Ively
Road, Farnborough, Hants, U14 OLX.

b. The method assesses the ability of the candidate additive to inhibit scuffing
wear on steel rubbing surfaces.

C. This test method is based on the standard ASTM D5001 Test Method for
Measurement of Lubricity of Aviation Turbine Fuels by the Ball-on-Cylinder Lubricity
Evaluator (BOCLE). It utilizes the same testing equipment and overall methodology
with some modifications.

0702. OUTLINE OF METHOD

a. A fluid sample containing the Candidate additive is placed in a reservoir in which
the air atmosphere is maintained at 60 % RH (relative humidity) at 25 °C. A fixed steel
ball in a vertically mounted chuck is forced against an axially mounted steel ring with
an applied load. The ring is rotated at a fixed speed while being partly immersed in the
fluid. The ring remains wet with the fluid and continuously transports it to the ball/ring
interface. The size of the wear scar generated on the ball is a measure of the scuffing
inhibiting property of the additive.

0703. WARNINGS

a. WARNING — Compressed gas under high pressure. Use with extreme caution
in the presence of combustible materials.

b. WARNING - Flammable vapours can cause flash fires.

0704. APPARATUS
a. Ball-on Cylinder Lubricity Evaluator (BOCLE) as stated in ASTM D5001 and
shown in Figure 1, except that the load descent distance is to be reduced to 1 mm by

fitting a suitable spacer into the support cylinder as shown in Figure 2.

b. Constant Temperature Bath Circulator, capable of maintaining the fluid sample
at (25 +1) °C when circulating heat transfer fluid through the base of the reservoir.

C. Microscope capable of 100X magnification with a glass slide micrometer having
a scale ruled in 0.01 mm divisions.
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d. Ultrasonic bath of adequate capacity.

e. Desiccator containing a suitable drying agent.

f. Vessels for the cleaning procedure:
1) Vessel A: 500 ml stainless steel dedicated to initial ball and ring
cleaning.
2) Vessel B: 500 ml stainless steel dedicated to a mixture of equal parts by
volume of propan-2-ol and petroleum spirit (or 2,2,4-trimethylpentane).
3) Vessel C: 500 ml stainless steel dedicated to petroleum spirit for primary
stage cleaning.
4) Vessel D: 500 ml stainless steel dedicated to petroleum spirit for
secondary stage cleaning.
5) Vessel E: 500 ml stainless steel dedicated to acetone.

g. Clay Treatment.

h. Glass filter holder of 300 ml capacity with glass support.

i. One 500 ml glass flask suitable for filter holder.

j- One 500 ml flask with stopper for clay treatment.

k. Clamp for holding filter holder and flask together.

l. Whatman No 2 paper filters.

m. Vacuum pump.

REAGENTS AND MATERIALS

a. Test ring (NOTE 1) of SAE 8720 steel having a Rockwell hardness ‘C’ scale
(HRC) number of 58 to 62 (Hardness Vickers number HV655 to HV750) and surface
texture, Ra, 0.56 mm to 0.66 mm. Itis recommended that eight surface measurements,
in the axial direction, be made on each ring at points around the outside diameter and
an average taken to confirm compliance with these requirements.

b. Chrome alloy steel test ball made from AISI steel No E-52100 with a diameter

of 12.7 mm (0.5 in) grade 5 to ten extra polish finish. The HRC shall be 64 to 66 (HV
800 to 860).
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Note 1: UK suppliers of test rings and balls are:
Rings and balls:

MED-LAB Limited
Copeland Street
Derby

DE1 2PU

Balls, part No SKF RB12.7/310996A:

BSL

Unit 5

The Rutherford Centre
Rutherford Road
Basingstoke

G24 8PD

Rings, part No F-25601.:

Falex International Ltd
PO Box 349

Ascot

Berkshire

SL5 9SR

C. Compressed air containing less than 0.1 ppm hydrocarbons and less than 50
ppm water.

d. Gloves, clean, lint-free, cotton, disposable.
e. Wiping tissue, light duty, lint-free, hydrocarbon-free, disposable.

f. Propan-2-ol, 2,2,4-trimethylpentane and acetone, Analar grade. Petroleum
spirit boiling range 60 °C to 80 °C.

g. Reference Fluids.

1) Fluid 1 — A low lubricity reference fluid, Isopar M (NOTE 2) clay treated
according to the procedure under subparagraph h and with 10 mg/l of an
approved anti-oxidant (NOTE 3) added after treatment. The fluid shall be tested
according to section 0708. Experience has shown that an average ball wear
scar diameter of (0.8 £ 0.08) mm is produced.

2) Fluid 2 — A high lubricity reference fluid, Isopar M clay treated according
to the procedure in subparagraph h and with 20 mg/l of linoleic acid (NOTE 4)
added after treatment. The fluid shall be treated according to section 0708.
Experience has shown that an average ball wear scar diameter of (0.50 £(10.04)
mm is produced.
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Note 2: Manufactured by EXXON Chemicals and supplied by: Multisol Limited,
48A Kings Street, Knutsford, Cheshire, WA16 6DX.

Note 3: Approved anti-oxidants are listed in Def Stan 91-91.

Note 4: Linoleic Acid is available from Aldrich Chemical Company Ltd, The Old
Brickyard, New Road, Gillingham, Dorset, SP8 4JL.

h. Clay Treatment Procedure.
1) Set up the filtering equipment as shown in Figure 3.

2) Using 250 g of clay (NOTE 5) per litre of Isopar M, shake the mixture in
a flask with stopper for 1 minute.

3) Filter using the technique shown in Figure 3.

4) Add 10 ppm of an approved anti-oxidant (NOTE 3) to the filtrant and mix
thoroughly.

Note 5: Clay is White Bentonite (Mineral colloid BP) and is available from
Fordomin Ltd, Yate Mills, Broad Lane (off Goose Green Way), Yate, Bristol
BS17 5LA.

I. Test Fluid.

1) The test fluid for qualification testing of an additive shall be 25 mg/I
additive in Isopar M.

0706. PREPARATION

a. Cleaning of Equipment and Test Components.
1) Cleaning of balls and rings as received.
a) The balls and rings shall be stripped of any protective coating by

manually rubbing them with rags or paper towels saturated with 2,2,4-
trimethylpentane.

b) Immerse partially cleaned balls and rings in Vessel A containing
petroleum spirit and clean ultrasonically for 10 minutes.

C) Repeat 6.a.1.b with fresh petroleum spirit.
d) Rinse balls and rings with fresh petroleum spirit.
e) Immerse balls and rings in Vessel B containing fresh propan-2-

ol mix (equal parts by volume of propan-2-ol and petroleum spirit or
2,2 4-trimethylpentane) and clean ultrasonically for 10 minutes.
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f) Handle all clean rings and balls with clean forceps or disposable
gloves.
0) Rinse the balls and rings with fresh petroleum spirit in vessel D
and blow dry.
h) Rinse the balls and rings with fresh acetone in vessel E and blow
dry.
i) Dry and store in a desiccator.

2) Cleaning of Components Between Runs (Note 6).

a) Cleaning of balls, rings and machine parts — Reservoir and

cover, Ball Chuck, Ball Lock Ring, Ring Mandrel Assembly Wrenches
and Tweezers.

Note 6: Vessels used for this cleaning procedure should be dedicated
to the procedure as stated in section 0704.f.

b) Rinse the components with fresh petroleum spirit in Vessel C.
Change solvent every test, but waste from Vessel D can be used.

C) Immerse the components in fresh propan-2-ol mix in Vessel B
and clean ultrasonically for ten minutes. Change the solvent after every
test.

d) Rinse the components in fresh petroleum spirit in Vessel D and

blow dry. Transfer used solvent to Vessel C.

e) Rinse the components in acetone in Vessel E and blow dry.
Change the solvent after every five tests.

0707. ASSEMBLY AND OPERATING PROCEDURE

a. Visually inspect test balls before each test. Discard balls that exhibit pits,
corrosion or surface abnormalities.

b. The assembly and operating procedure in section 10 of ASTM D5001
(Procedure) applies with the following changes:

1) The operating air pressure is 180 kPa.

2) The conditioning gas is air at (60 £+ 0.2) % Relative Humidity (RH).
3) The conditioning period is 15 minutes.

4) The test period is 2 minutes.

5) The applied load is 2 kg (1 kg mass on arm).
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6) The arm drop time is set to 10 s with 1 kg applied load (500 g on arm)
and 1 mm drop distance.

C. Procedure.
1) A summary of test conditions is included in Table F-1.
2) The cleaned components are assembled and fitted to the BOCLE.

3) (50 £ 1) ml of test fluid is placed in the bath.

4) The loading arm drop time is checked. This should be 10 s with a load
of 1 kg (500g on arm) at 180 kPa.

5) The motor and the 5 minutes conditioning period are started.
6) After the 15 minutes the load is applied via the loading switch.

7) After 2 minutes the load is released. The load switch and timer are
turned off and the motor stopped.

8) The apparatus is stripped and the components closed.
9) Remove the test ball from locking nut, but not from the blue retaining
ring. Wipe clean with wiping tissue and measure scar diameter under the

microscope (see ASTM D5001 section 11 (Measure of the Wear Scar)).

0708. CALIBRATION AND STANDARDIZATION

a. Reference Fluids.

1) Carry out three tests on each new batch of the reference fluids in
accordance with section 0707 using a ring previously calibrated by reference
fluid testing. Repeat the three tests if the wear scar diameters differ by more
than 0.08 mm for Reference Fluid 1 or by more than 0.04 mm for Reference
Fluid 2.

Reject the Reference Fluid batch if:
a) The wear scar diameters for the repeat tests again differ by more
than the 0.08 mm for Reference Fluid 1 or by 0.04 mm for Reference

Fluid 2.

b) The average wear scar diameter for the three results does not
fall within the following values.

- Reference Fluid 1 — 0.72 mm to 0.88 mm
- Reference Fluid 2 — 0.46 mm to 0.54 mm
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b. Rings
1) Test each new ring with Reference Fluid 1. The ring is acceptable if the
ball wear scar diameter is within 0.72 mm to 0.88 mm. If not, carry out a repeat

test. Reject ring if:

a) The two values for wear scar diameter differ by more than 0.08
mm from each other.

b) Both the values for wear scar diameter are not within 0.72 mm
to 0.88 mm.

2) Test each new ring with Reference Fluid 2. The ring is acceptable if the
wear scar diameter is within 0.46 mm to 0.54 mm.
If not, carry out a repeat test. Reject ring if:

(a) The two values for wear scar diameter differ by more than 0.08
mm from each other.

(b) Both the values for wear scar diameter are not within 0.46 mm

to 0.54 mm.
C. Levelling of Load Arm.
1) The level of the load arm shall be inspected before every test. For
adjustment instructions see section 9.4 in ASTM D 5001 (Leveling of the Load

Arm).

0709. MEASUREMENT OF THE WEAR SCAR

a. Position the test ball under the microscope such that the scar is centred within
the field of view. Measure the major and minor axes to the nearest 0.01 mm. Record
the readings on the Data sheet as shown in Figure 4. Note condition of wear area if
different from reference test, that is, debris colour, unusual particles or wear pattern
and particles in the reservoir etc.
b. Calculate the wear scar diameter as follows:

WSD = (M+N)/2

where,

WSD = Wear Scar Diameter, mm

M = Major Axis, mm

N = Minor Axis, mm

0710. REPORT

a. Report the test conditions and results on the data sheet as shown in Figure 4.
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0711. PRECISION

a. The precision, repeatability and reproducibility of the method has yet to be
established. However, experience has shown that the precision criteria in ASTM
D5001, section 14 (Precision and Bias) may be used as a guide.

TABLE F-1
Operating Conditions
PROPERTY LIMITS

Fluid Volume 50 ml + 1.0 ml
Fluid Temperature 25°C +1°C
Conditioned Air 60 % + 0.2 % RH (at 25 °C)
Conditioning Time 15 minutes
Ring Rotational Speed 240 r/min £ 1 r/min
Applied Load 2 kg (1 kg weight)
Arm Drop Time 10 s using 1 kg weight (0.5 kg on arm)
Test Duration 2 minutes
Fluid Pretreatment: 0.5 I/min of conditioned air flowing through and 3.3 I/min flowing over
the fluid for 15 minutes
Fluid Test Condition: 3.8 I/min of conditioned air flowing over the fluid.

SPIRIT LEVEL BALL CLAMP ASSEMBLY
LOADING ARM
\'x r;( LOADING HOOK
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CJ & e
- L =
_— . : _jl___Pmruh:
LOCK ASSEMBLY - b= .
e |[ e — . F"“““'“WE IGHT
ARM LIFT AND
SUFFORT CYLINDER
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Figure 1: Schematic Diagram of BOCLE:
Ball-on-cylinder Lubricity Evaluator
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Figure 2: Modification to Arm Support Cylinder
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Figure 3: Filtering Technique
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Scuffing Test

Sample:

Ring No. Track No.

Ambient temperature, °C

Base Temperature, °C start

Base Temperature, °C end

Base Temperature controlled (Y/N)
Precondition reservoir time

Start test time

Air Humidity

Ring Speed, r/min

Applied load, kg

Fuel volume used, mi

Scar Type: Elliptical Circular

Minor axis, mm

AFLP-3390

Ball No.

Major axis, mm

WSD, mm

Observations:

Other

Figure 4. Data Sheet
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